Ringtail Basics
Quick Start Guide

Ringtail 9 brings a new level of simplicity, ease of use, and efficiency to document review. The following pages walk through scenarios, based on common tasks, to show the Ringtail features that make the interface easier to use and that add speed and accuracy to review tasks.
Log in and select a case

Follow the Ringtail link that was provided by your administrator and log in to Ringtail.

On the Portal Home page, click the name of a case.

You can pin frequently accessed cases to the top of the list.

**Note:** If you bookmark the link to Ringtail, use the address that was provided by your administrator or the address of the Portal Home page, rather than the address of the login page.

**Note:** Your administrator must enable and configure some features.
View notifications

To see notifications from your administrator, on the Portal Home page, click the **Notifications** bell on the toolbar.

*Note:* Your administrator must enable and configure some features.
On the Case Home page, the **Case Site Map** allows you to access key features in Ringtail quickly.

**Note:** Your administrator must enable and configure some features.
Case Home page: My Assignments and Review Dashboard

Users with permissions can access the following pages from the navigation pane on the Case Home page:

**My Assignments**

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Total</th>
<th>Remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase A - 8</td>
<td>23</td>
<td>Get</td>
</tr>
<tr>
<td>Phase A - 9</td>
<td>90</td>
<td>Get</td>
</tr>
</tbody>
</table>

**Review Dashboard**

- Document set: All documents in the case
- Coding field: [DEMO] Default 1P

- 9% coded: 80,180 / 845,818 documents
- Estimated completion: No recent review.
- Average documents coded per reviewer: No recent review.

- Team: All teams

- Documents coded:
  - All reviewers: 0 (Today), 0 (Average per day), 0 (Previous 7 days), 80,180 (All time)
  - Booth1, Booth1: 0 (Today), 0 (Average per day), 0 (Previous 7 days), 15 (All time)
  - Booth3, Booth3: 0 (Today), 0 (Average per day), 0 (Previous 7 days), 50 (All time)

**Note:** You can also access your assignments on the Documents page, in the Browse pane.

**Note:** Your administrator must enable and configure some features.
The Concept Cloud displays a word cloud of the concepts that were found in a specific document set. The larger the word, the more common the concept is. You can display concepts for all documents in the case, or for documents in a binder, issue, population, sample, or workflow or phase. Use the slider to hide common concepts and display less common concepts.

To view documents that contain a concept, click a word in the Concept Cloud. For example, if you click the word “commission” in the Concept Cloud, Ringtail performs a search and displays your results on the Documents page.

**Note:** Your administrator must enable and configure some features.
The Case Home page includes some or all of the following items:

**Navigation bar:** This bar at the top includes the following items (from left to right):
- **Ringtail logo:** Click the Ringtail logo to navigate to the Portal Home page from any page in the case. You can open a different case from the Portal Home page.
- **Case name:** Click the case name to return to the Case Home page from any page in the case.
- **Case Home menu:** Use this menu to access different areas of Ringtail, such as the Documents page or the Review Setup page. The Case Home menu and Documents option always appear. The Transcripts option appears if you have permission to access transcripts that are loaded in the case, and the remaining menu options appear if you have permission to access the associated pages.
- **Quick search box:** Type a word or phrase in this box to perform a quick search.
- **Quick search menu:** Use this menu to change the quick search options. The options that appear on this menu depend on your permissions.
- **Group name and menu:** If you belong to multiple groups, you can switch between groups that are listed on the menu.
- **User name and menu:** Hover over your user name to view details. To log out of Ringtail, click Log out on the menu. You can also click the user name menu to set search preferences, reset your workspace to the default settings, or access bookmarks.
- **Help button:** Click this button to search the online help, training videos, and other resources. To open the online help, click the Documentation button. You might also see buttons to submit a support ticket (Ticketing) or contact customer support (Get Help).

**Toolbar:** This bar includes the following items:
- **Breadcrumb and breadcrumb menu:** Breadcrumbs allow you to track and navigate back to Ringtail pages. Click the arrow next to the Home button to open the breadcrumb menu, which displays the same list of Ringtail pages as the Case Home menu.
- **Browse:** Click this button to open the Documents page with a workspace that contains the Browse pane.
- **Search:** Click this button to create a new advanced search on the Search page.

**Case Site Map:** Allows you to access key features more quickly, such as assignments or cubes. You can also access your results history and document history, and documents that were recently added to the case. If enabled, this page also includes a “What’s new in Ringtail” section. Follow the link to read about the latest Ringtail features.

**Information bar:** The information bar at the bottom of every page contains copyright and version information.

*Note:* Your administrator must enable and configure some features.
On the Documents page, you can browse, find, review, and code documents.

To open the Documents page, perform a search for documents. Or, on the Case Home page > Case Site Map, click a link under **Documents Added, Results History, or Document History**.

<table>
<thead>
<tr>
<th>DOCUMENTS ADDED</th>
<th>RESULTS HISTORY</th>
<th>DOCUMENT HISTORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/26/2018 (1)</td>
<td>&quot;Binder - Shared&quot; is &quot;All ESSO&quot;) including Sources/Attachments (4,078)</td>
<td>4/11/2018 (31)</td>
</tr>
<tr>
<td>2/22/2018 (1)</td>
<td>&quot;Concepts&quot; is &quot;commission&quot; (88,746)</td>
<td>4/10/2018 (3)</td>
</tr>
<tr>
<td>1/16/2018 (23)</td>
<td>&quot;Thread Analysis Status&quot; is &quot;Success&quot;) Threaded view including Sources/Attachments (1,342,428)</td>
<td>4/4/2018 (2)</td>
</tr>
<tr>
<td>1/12/2018 (3)</td>
<td>&quot;Document Content&quot; contains &quot;raptor&quot; (3,526)</td>
<td>4/2/2018 (10)</td>
</tr>
<tr>
<td>12/21/2017 (9)</td>
<td>&quot;Assignment ID&quot; is &quot;533474&quot;) including Sources/Attachments (1)</td>
<td>4/2/2018 (24)</td>
</tr>
<tr>
<td>All documents (1,824,239)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Ringtail displays the Documents page with the default workspace.

**Note:** Your administrator must enable and configure some features.
The Documents page includes some or all of the following items on the toolbar (from left to right):

- **Search results arrows:** Use the arrows on the left to quickly browse through search results.
- **Search description:** Click the description of the search results to open the search.
- **Document information:** This information appears below the search results arrows and can include the following information:
  - Search preferences indicator: a threaded icon appears if **Threading** was enabled for the search, a paper clip icon appears if **Sources and attachments** was enabled, and a rendition icon appears if **Renditions** was enabled.
  - A button that allows you to copy the active Document ID to the clipboard.
  - The active Document ID. On the Documents page toolbar and elsewhere in Ringtail, a triangle icon indicates the active document:

- **Browse:** Click the **Browse** button to open the Browse pane, if it is not already open.
- **Search:** Click the **Search** button to create a new advanced search.
- **Workspaces buttons and menu:** To change the current workspace configuration, click a different workspace button. To open a menu that allows you to add a new workspace, modify an existing workspace, or select workspaces to pin to the toolbar, click the arrow next to the workspaces button.
- **Tools:** To use document tools, click the arrow next to the **Tools** button.
- **Document arrows:** Use the arrows on the right to quickly browse through documents in the results set.

**Tip:** To increase the height of your workspace, you can collapse the Documents page toolbar. Click the **Collapse** button on the navigation bar, next to the Help button.

**Note:** Your administrator must enable and configure some features.
Work with assignments

You can access your assignments in the Browse pane. To open the Browse pane, on the Case Home page or the Search page, click the Browse button on the toolbar. Then, click the Assignments section in the Browse pane.

**Note:** If you do not see the Assignments section in the Browse pane, click Options on the Browse pane menu. Then, add the Assignments section to the Browse pane.

- To get the next set of documents that are assigned to you, click the Get next assignments button on the toolbar.
- To open all documents in an assignment, click an assignment name.
- To open any uncoded documents that still require review, in the Remaining column, click Get.

When you open an assignment, Ringtail displays the documents that require coding or review. The workspace panes that the documents appear in depend on your workspace configuration. The documents typically appear in the List pane.

If an assignment meets the coding requirements, the assignment is automatically cleared when you open it.

To clear a completed assignment, suspend an assignment, or resume an assignment, click the Options menu next to an assignment, and then select an action. Group leaders can also revoke assignments.

To manage your assignments on the My Assignments page, click the Manage button on the toolbar.

**Note:** Your administrator must enable and configure some features.
Set search preferences

You can set preferences for searches, including whether you want your search results to include threaded documents, attachments with source documents, or renditions. You can also include line numbers when your search results appear in the List pane. All options are cleared by default.

The Search preferences menu is available on the user name menu on the navigation bar of any page in the case.

After you save your search preferences, Ringtail applies your preferences to all subsequent searches.

**Note:** The options that you set on the Search preferences menu sync with the search preference options at the bottom of the Search page.

**Note:** Your administrator must enable and configure some features.
Perform a simple search

Use the quick search box, which is available on the navigation bar of all pages in the case, to perform simple searches.

Start typing in the quick search box to start your search. In the results list, you can filter by certain search parameters.

If you have permissions, you can also manage the properties or security for objects such as binders.

To change the type of search, click the gear button next to the quick search box. Then, select a search option on the menu.

**Note:** Only one option, **Document Content**, is selected by default.

*Note:* Your administrator must enable and configure some features.
Browse and filter documents

To open the **Browse** pane, on the Case Home page or the Search page, click the **Browse** button on the toolbar. The first workspace that includes the Browse pane appears, and displays the Browse features available to you.

In the Browse pane, you can perform the following tasks:

- **Browse for a new document set.** To do this, click the name of the item that you want to browse for. For example, you can locate the documents in a binder, or browse to the documents that contain a specific concept.
- **Select and filter documents within the current document set that meet various criteria.** To do this, select the check box next to the criteria. For example, you can select all of the documents that are coded with a specific quick code value or that are designated with a specific issue, and then filter the results set to display only those documents.
- **Use the Find feature to select documents within a results set based on content hits or coding values.**

You can customize the sections that appear in the Browse pane. For example, you can add pick lists as new sections. To do this, click the **Options** button.

The Browse pane also includes additional functions for managing concepts, viewing and modifying descriptions, and downloading concept reports.

**Note:** Your administrator must enable and configure some features.
Perform an advanced search

You perform advanced searches on the **Search** page. To access the Search page, click the **Search** button on the Case Home page or the Documents page.

- Select from a wide range of fields, operators, and values.
- To set search preferences, select the check boxes at the bottom of the page.
- To run the search, click **Search** at the bottom of the page.

To clear the current search criteria and create a new search, click **Reset**.

To use the previous search criteria in a new search, click the search results name on the toolbar.

**Note:** Your administrator must enable and configure some features.
Build an advanced search query

Build your search using the values, operators, and buttons on the Search page.

- **Gray** bracket: Group of search queries.
- **Green** bracket: Group of search queries joined by an “or” operator.
- **Red** bracket: Group of search queries joined by an “and” operator.
- **Blue** bracket: Group of search queries joined by a “not” operator.

**Example search clause and search buttons**

- Add new clause
- Add additional criteria (Coded by)
- Remove additional criteria
- Delete clause
- Create group
- Remove from or delete group
- View selection (for example, mines and cubes)
- Run only this line of the search query

**Tip:** To build your search without using a mouse, click the **Keyboard Shortcuts** button on the Search menu to see a list of keyboard shortcuts.

**Note:** Your administrator must enable and configure some features.
Work with Search Terms

You can view statistics for search term hits in documents using the Search Terms reporting feature.

To access the Search Terms page, on the Case Home page, under Analysis, click **Search Terms**.

- In the Counts section, you can view information about search term hits across document sets. You can also view how each search term contributes to the overall population of hits at a document and family level.
- In the Coding section, you can review how many documents containing a particular term were coded with specific values. This allows you to evaluate search term effectiveness using recall and precision values.

You can download the full report as a spreadsheet (.csv file).

**Note:** Your administrator must enable and configure some features.
The workspace is the arrangement of panes on the Documents page. The workspace appears when you open the Documents page after you run a search or browse a document collection.

You can perform different tasks in each pane, as follows:

- Use the **Browse** pane to open your assignments, browse for a new document set, select and filter documents within the current results set that meet various criteria, or find document content or coding hits.
- Use the **List** pane to see information about each document, along with coding and document hits details.
- Use the **View** pane to view a document’s text content, native files, and image files.
- Use the **Code** pane or the **Conditional Coding** pane to code documents.
- Use the **Map** pane to see a visualization of documents that are clustered based on the similarity of concepts.
- Use the **Timeline** pane to review the distribution of documents over time.
- Use the **Related** pane to see a list of documents that are related to each other based on threaded relationships, source and attachment relationships, or similarity of concepts.
- Use the **Compare** pane to view the differences between the text of two documents.
- Use the social network analytics panes (**Domain Network**, **Communication Network**, and **Concept Cloud**) to view the communication patterns between people and organizations.

**Tip:** You can collapse or resize any of the panes, if you need more space. If you narrow the width of a pane, the pane name collapses into a menu.

**Note:** Your administrator must enable and configure some features.
Customize the workspace

To change the current workspace, click one of the three pinned workspace buttons (A, B, or C) on the toolbar. Or, click a workspace name on the workspace menu.

You can pin up to three workspaces to the toolbar. To pin a different workspace to the toolbar, open the workspace menu, and then click the pin next to a workspace.

To add a new workspace or edit the panes in an existing workspace, open the workspace menu. Then, click **Add new workspace** or **Edit current workspace**.

You can configure a workspace to contain up to five panes, including **Browse**, **Code**, **Communication Network**, **Compare**, **Concept Cloud**, **Conditional Coding**, **Domain Network**, **List**, **Map**, **Related**, **Timeline**, **View (A)**, and **View (B)**.

**Note:** If you do not see the default workspaces for your group, on the user name menu, under **User settings**, select **Reset to group default**.

**Note:** Your administrator must enable and configure some features.
Work with documents in the List pane (standard view)

When you search for documents, the results typically appear in the List pane on the Documents page. The List pane includes information about each document, along with coding and document details.

Use the List pane to perform the following tasks:

- Select documents to view and code.
- Select documents for the Working list.
- Apply quick codes to documents.
- Work with email threads.
- Work with base documents and renditions.
- Filter and search the documents in the List pane.
- Open a document in a linked workspace or in a standalone window.
- Copy the link to selected documents.
- Find similar documents.

To download a list of documents, click Download on the List menu.

**Note:** To display line numbers in the List pane, select the Line numbers option on the Search preferences menu (on the user name menu or the Search page).

**Note:** Your administrator must enable and configure some features.
Configure columns in the List pane

You can add or remove columns in the List pane, change the display order of columns, and select the default sort order for columns.

To quickly access a set of columns in the List pane, save the columns as a column template.

Note: Your administrator must enable and configure some features.
Filter columns in the List pane

After performing a search, you can narrow your search results by filtering the columns in the List pane. You can filter for text, dates, yes/no values, or numbers.

To return to the unfiltered results for the search, click the left arrow button on the left side of the toolbar.

After you apply a filter, the criteria used for the filter become part of the search label. You can click the search label to open an advanced search with these criteria on the Search page.

Note: Your administrator must enable and configure some features.
Edit fields inline in the List pane

You can edit the values of some fields directly in the List pane. Fields that can be coded directly in the List pane appear with an icon in the column heading.

Double-click a field to edit its value.

You can undo changes made to editable fields in the List.

Note: Your administrator must enable and configure some features.
Print documents to PDF

You can print documents to PDF using the **Batch Print** tool, which is located on the **Tools** menu. After you print documents to PDF, you can use the print options in your PDF viewer to print hard copies.

You can print documents that contain image files or PDF files. You can specify whether to include highlights, redactions, and footers.

You can print each document separately or combine multiple documents into one PDF file.

**Note:** Your administrator must enable and configure some features.
Work with the email threading feature

The email threading feature analyzes document content and organizes email conversations into threads.

You can use email threading to perform the following tasks:

- Shorten review time by removing duplicate documents and coding only pivot documents.
- Increase review efficiency and accuracy by reviewing threaded documents together.

In threaded view in the List pane, you can review documents using both standard and threading-specific elements.

Threading-specific icons in the Thread Data column show the following information:

- Pivot documents. Pivot documents contain unique content. A thread can have one or more pivots.
- Recipient and attachment changes within a thread.

Note: Your administrator must enable and configure some features.
Work with the email threading feature

To work with the email threading feature, perform the following steps:

1. Select the Threading option on the Search preferences menu (on the user name menu or the Search page).
2. Return a set of documents.
3. Add documents to thread analysis or remove documents from thread analysis by using the Thread analysis option on the Tools menu.

4. After Ringtail has analyzed the documents and created threads, review the threaded documents.
   - To view just the pivot and root documents in a thread, click the **Collapse all threads** button on the List menu. To view all documents in a thread, click the **Expand all threads** button.
   - To select only the pivot documents and their attachments, use the **Select pivot** option at the top of the List pane.

**Note:** Your administrator must enable and configure some features.
Review documents in the View pane

When you review a document, you determine the document’s relevance to a case and identify any important content. You review the content of individual documents in the View pane.

The View pane includes different view options to allow you to review a document in the format that is most appropriate for the document type, the case strategy, and the overall goals of the review. Because you can see different content in each view, it is important to review documents in all views.

Depending on the tasks that you want to accomplish, the type of document you are reviewing, and the specific content that you want to review, you can view a document in the following formats:

- **Formatted content:** Displays the text extracted from a document, with simple formatting applied.
- **Unformatted content:** Displays the text extracted from a document without any formatting.
- **Native:** Displays a document in the native file format of the original application that created the document, using the Quick View Plus viewer.
- **Office Online viewer:** Displays a native document in Microsoft Office Online directly in the browser.
- **Image viewer:** Displays image files, PDF documents, and media files.

*Note:* Your administrator must enable and configure some features.
Review documents in the View pane: Formatted content view

**Formatted content** view displays the text extracted from a document, with simple formatting applied.

You can perform the following tasks:
- View keyword hits.
- Conduct ad hoc keyword searches.
- Search for similar documents based on a selection of text.
- View streamlined Bloomberg chats, with interactive color-coding based on participants’ organizations.

**Note:** Your administrator must enable and configure some features.
Review documents in the View pane: Unformatted content view

**Unformatted content** view displays the text extracted from a document without any formatting.

You can perform the following tasks:
- View keyword hits.
- Conduct ad hoc keyword searches.
- Search for similar documents based on a selection of text.

**Note:** Your administrator must enable and configure some features.
Review documents in the View pane: Native view

Native view displays a document in the native file format of the original application that created the document, using the Quick View Plus viewer.

You can perform the following tasks:
• Search for content.
• Watch video files and listen to audio files.

Note: Your administrator must enable and configure some features.
Review documents in the View pane: Office Online viewer

The **Office Online viewer** displays native files directly in Ringtail using Microsoft Office Online. You can review native files without having to download documents to your computer.

You can perform the following tasks:

- Search for content.
- See formulas*, resize columns, and display hidden worksheets, rows, and columns* in a Microsoft Excel spreadsheet.
- View comments in Microsoft Word*, Microsoft Excel, and Microsoft PowerPoint.
- View slide notes*, slide thumbnails*, and hidden slides* in a Microsoft PowerPoint presentation.
- Use standard Microsoft Office features to review content*.
- View native files that were created in applications other than Microsoft Office.
- Watch video files and listen to audio files.
- Display hidden content.

**Note:** Depending on the portal configuration, you may be able to edit documents temporarily, such as adding temporary highlights. Ringtail does not save any edits that you make in the Office Online viewer.

* The availability of features marked with an asterisk (*) depends on your organization's license with Microsoft and the portal options that are configured by your administrator.

**Note:** Your administrator must enable and configure some features.
Review documents in the View pane: Image viewer

The **Image viewer** displays image files, PDF documents, and media files.

You can perform the following tasks:
- View imaged document pages.
- Add annotations such as highlights or redactions.
- Search for text to highlight or redact in searchable PDFs.
- Convert highlights to redactions, and convert redactions to highlights.
- Add notes to specific document pages.
- Print a document.
- Watch video files and listen to audio files.
- View comprehensive Bloomberg chats, including event logs and noise content.

**Note:** Your administrator must enable and configure some features.
### View pane features

The following table describes the features in the View pane.

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatted content</td>
<td>Displays the text extracted from a document, with simple formatting applied.</td>
</tr>
<tr>
<td><img src="image" alt="Formatted content icon" /></td>
<td></td>
</tr>
<tr>
<td>Unformatted content</td>
<td>Displays the text extracted from a document without any formatting.</td>
</tr>
<tr>
<td><img src="image" alt="Unformatted content icon" /></td>
<td></td>
</tr>
<tr>
<td>Native</td>
<td>Displays a document in the native file format of the original application that created the document, using the Quick View Plus viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Native icon" /></td>
<td></td>
</tr>
<tr>
<td>Office Online viewer</td>
<td>Displays native files in Microsoft Office Online directly in the browser.</td>
</tr>
<tr>
<td><img src="image" alt="Office Online viewer icon" /></td>
<td></td>
</tr>
<tr>
<td>Image viewer</td>
<td>Displays image files, PDF documents, and media files.</td>
</tr>
<tr>
<td><img src="image" alt="Image viewer icon" /></td>
<td></td>
</tr>
<tr>
<td>Quick code field and document type icon</td>
<td>The icon shape indicates the document type. If quick coding is enabled, the color of the icon indicates the quick code value of the document. Click the document type button to apply a quick code to a document.</td>
</tr>
<tr>
<td><img src="image" alt="Quick code field icon" /></td>
<td></td>
</tr>
<tr>
<td>Quick code family field</td>
<td>A colored line next to the document type button indicates that the document is part of a document family. A document family consists of a source document and its attachments. The color of the line indicates the highest-ranking quick code that is applied to a document in the document family.</td>
</tr>
<tr>
<td><img src="image" alt="Quick code family field icon" /></td>
<td></td>
</tr>
<tr>
<td>Document ID</td>
<td>The ID number of the document that appears in the View pane. The document ID is a unique number that is associated with each document in the database. The document that appears in the View pane is also called the active document.</td>
</tr>
<tr>
<td><img src="image" alt="Document ID icon" /></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Your administrator must enable and configure some features.
# View pane features

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden content warning ![1]</td>
<td>Indicates that a native file includes hidden content, such as tracked changes, speaker notes in a presentation, or hidden columns in a spreadsheet. Hover over the warning icon to determine the type of hidden content that the document contains.</td>
</tr>
<tr>
<td>Truncated content warning ![1]</td>
<td>Indicates that a document is larger than the maximum file size set by your administrator. To see the whole document, switch to a different view or download the document.</td>
</tr>
<tr>
<td>Keyword hit navigation ![1/17 ▶ ▼]</td>
<td>Displays the number of keyword hits in the document. To navigate between keyword highlights in the document, click the Next hit or Previous hit buttons.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the document is larger than the maximum file size set by your administrator, only the number of visible keyword hits appears.</td>
</tr>
<tr>
<td>Keyword highlights ![1]</td>
<td>Displays keyword highlights and allows you to conduct ad hoc content searches.</td>
</tr>
<tr>
<td>Find and redact ![1]</td>
<td>Allows you to find text in a searchable PDF document, and then add highlights or redactions to the text.</td>
</tr>
<tr>
<td>Show hidden content ![1]</td>
<td>Displays hidden content in Microsoft Excel, Word, and PowerPoint documents.</td>
</tr>
<tr>
<td>Download ![1]</td>
<td>Downloads a document in its original file format.</td>
</tr>
<tr>
<td>Update pages ![1]</td>
<td>Allows you to add or remove pages in a document, if you have permission to do so.</td>
</tr>
<tr>
<td>Collapse</td>
<td>Collapses the View pane.</td>
</tr>
<tr>
<td>View menu and options</td>
<td>The View menu includes options for working with documents in the View pane.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can pin any of these buttons to the View pane toolbar.</td>
</tr>
</tbody>
</table>

**Note:** Your administrator must enable and configure some features.
Code documents

Coding a document is the process of marking a document with the information that you identify during a review. Documents that are coded as responsive can then be produced and provided to a third party in response to a discovery request.

Depending on your case, you can code documents in the **Code pane** or the **Conditional Coding pane**.

In the **Code pane**, you can perform the following tasks:

- View the existing coding values for a document.
- Quickly code a document by selecting a color-coded value from a list (called a quick code).
- Apply suggested coding values to a document using hints.
- Code documents to fields, issues, binders, people, and organizations.
- Link a document to related objects, such as other documents, shared binders, issues, and levels.
- Locate documents that are coded with the same values.
- Configure the layout of the Code pane.

**Note:** Your administrator must enable and configure some features.
Code documents in the Code pane

- To save field edits, press Tab or Enter.
- To delete field edits, click the field value, and then press Delete.
- Multivalue fields display a plus sign and allow you to code multiple values.
- When coding pick list fields with many values, type a few letters to narrow the list of values.

Tip: To apply values from the previously displayed document, select a coding template on the All Values menu, and then use coding hints.

To edit a field, click in any field with a blue triangle and change its value.

To apply issue coding, on the All Values menu, select Issues, and then select one or more check boxes.

To apply a quick code, click the blue dot.

To search for documents that have the same coding, click the magnifying glass.

Note: Your administrator must enable and configure some features.
Code documents in the Conditional Coding pane

When you code documents in the **Conditional Coding** pane, you can quickly determine which fields, binders, and issues you should code depending on the values that you provide for related fields. After you code each object, the colors of the remaining objects change to indicate which items you still need to code.

Objects that you have already coded appear in green, objects that your administrator does not expect you to code appear in gray, and objects that must still be coded appear in white.

If you code a value that is unexpected based on the other values that you have coded, the object appears in yellow and a warning message appears.

**Tip:** You can use coding macros to code a document to a predefined set of values by clicking a single button. You can also use coding macros to code a document with the same values as the previous document.

To create a new coding macro, click the plus (+) button on the macro toolbar.

**Note:** To access this feature, add a Conditional Coding pane to your workspace.

**Note:** Your administrator must enable and configure some features.
Work with the Map

The Map pane is an alternate view of documents in an assignment or a search results set in which documents are clustered based on the similarity of concepts.

You can navigate from document to document, view relationships between documents, search documents, and code documents while viewing the Map.

You can display up to 10,000 documents per page.

You can perform the following tasks with the Map:

• Review documents based on their concepts.
• Explore concepts that tend to appear together in selected documents.
• Find documents that share common concepts.
• Apply quick codes to one or more documents directly in the Map.
• Find documents that have the same quick code or the same family quick code.
• Select multiple documents for a bulk action, such as coding or adding documents to a binder.
• Search the Map for keywords to locate clusters and documents with those terms.
• Select a document to preview in the View pane or in a standalone workspace.
• Discover new concepts in the documents.

Note: Your administrator must enable and configure some features.
The Map pane contains the following elements:

- **Concept cluster**: A group of documents in a spiral arrangement in a circle. The circle may appear solid when you first open the Map, indicating that all the documents in the cluster have the same quick code value. You can configure the Map to always display individual document dots.
- **Cluster tooltip**: A tooltip that appears when you hover over a cluster. The tooltip displays the concept shared by clusters displayed on the spine. When spines intersect, multiple concepts display at the top of the tooltip. The tooltip displays the top concept, the next highest six concepts, the number of documents in the cluster, the percent of documents coded, and the top document titles in the cluster. You can configure the Map to position the tooltip in the corner of the pane.
- **Spine**: A line that connects clusters that have one or more significant concepts in common. Along a spine, documents in adjacent clusters are more similar to each other than to documents in clusters that are farther away.
- **Spine label**: The concept that clusters in a spine have in common. The spine label appears around the concept compass. Spine labels can provide a quick overview of the key concepts in an area of the Map.
- **Concept compass**: The ring that surrounds concept clusters. Clusters can appear inside or outside the ring depending on the cluster configurations.
- **Set-aside clusters**: Square containers, or clusters, in the lower right for storing coded documents. The color indicates the quick code value. Use the Quick Codes section in the Browse pane to move documents between the Map and the set-aside clusters.
- **Triangle**: Indicates the active document.
- **Map menu**: The menu associated with the Map pane that lists options for using and configuring the Map. You can pin the options on the menu to the Map toolbar for easy access.
- **Page navigation window**: A small window on the side of the Map that appears when the Map includes more documents than can be displayed on one page. Use the navigation controls to move through documents on additional pages of the Map. You can configure the number of documents to view per page on the Map pane’s Options menu.
- **Zoom slider**: A vertical control on the right side of the Map that allows you to zoom in and out of clusters.

Note: Your administrator must enable and configure some features.
Work with the Timeline

In the **Timeline** pane, you can review the distribution of documents over time and determine how they intersect with other information, such as concepts, quick codes, content searches (find), and search term families.

You can perform the following tasks:

- Select documents in a time range, a specific time interval, or a selection of specific time intervals.
- As a reviewer, select a different Timeline date field to use during a review. The time field used to configure the Timeline is set at the case, group, and user level.

You can use the Timeline feature with result sets up to 50,000 documents.

**Note:** Your administrator must enable and configure some features.
Work with the Related pane

In the Related pane, you can review documents that are related to each other based on threaded relationships, source and attachment relationships, or similarity of concepts.

The Related pane includes the following sections:

- **Sources and attachments:** Displays the active document and any documents with a source or attachment relationship to the active document.
- **Threading:** Displays the active document and a list of documents with a threaded relationship to the active document.
- **Similar:** Displays the active document and a list of documents that share at least 70% of the same concepts. The number in the Similarity column indicates the fraction of concepts that the documents share in common.

You can perform the following tasks:

- Change the active document within a document family
- See the coding for related documents
- Apply quick codes to documents
- Review the documents that are similar to each document in a thread by pivoting from document to document
- Maximize a section, or collapse or expand sections

**Note:** Your administrator must enable and configure some features.
Work with the Compare pane

In the **Compare** pane, you can view the differences between the text of two documents.

To compare two documents, you anchor one of the documents that you want to compare. Select the document, and then click the **Set active document as anchor** button on the Compare pane toolbar. The first document is anchored in the left pane.

Then, select a second, similar document in the Related pane, the List pane, or the Map. In the Compare pane, the anchored document in the left pane remains unchanged. The second document that you selected, which is now the active document, appears in the right pane. The differences between the two documents are marked in red.

**Tip:** To locate documents that are good candidates for comparison, add a Related pane to your workspace. In the Related pane, in the Similar section, you can see a list of documents that share the same concepts.

The Compare pane is available for documents without branded redactions. The maximum file size is 3 MB.

---

**Note:** Your administrator must enable and configure some features.
Social network analytics: Overview

Use the social network analytics feature to view the communication patterns between people and organizations. This feature is well suited for early case assessments and investigations where you are not sure what you are looking for.

To work with the social network analytics feature, you can add the following panes to your workspace:

- **Domain Network**: Displays email communication between organizations.
- **Communication Network**: Displays email communication between people.
- **Concept Cloud**: Displays the concepts, or topics, that organizations or people are talking about.

The information in the panes stays in sync when you switch from one pane to another.

**Note**: Your administrator must enable and configure some features.
Social network analytics: Sample workflow

You can work with the social network analytics features with any search results set. A sample workflow might look like this:

1. Configure a workspace with the following panes: **Browse**, **Domain Network**, and **Communication Network**.
2. To explore the emails between organizations, in the **Browse** pane, in the **Organizations** section, select an organization.
3. View the results and visualization in the **Domain Network** pane to see which organizations are communicating with each other.
4. To view details about emails between people, select a line between two organizations in the **Domain Network** pane, and then view the visualization in the **Communication Network** pane.
5. Finally, add the **Concept Cloud** pane to your workspace to get an overview of which concepts, or topics, people are talking about.

**Note:** To view documents, add a **List** or **Map** pane, and a **View** pane, to your workspace.

**Note:** Your administrator must enable and configure some features.
Social network analytics: Domain Network and Communication Network panes

In the Domain Network pane, you can view email communication between organizations.

In the Communication Network pane, you can view email communication between people.

Note: Your administrator must enable and configure some features.
Social network analytics: Concept Cloud

In the Concept Cloud pane, you can see the topics that organizations or people are communicating about. The Concept Cloud pane displays the most important concepts for your search results. The larger the word, the more important the concept is.

To select the documents within your search results set that include a specific concept, click a concept name.

To see the concepts that specific documents contain, select the check box next to those documents. Then, click the Concept cloud for working list button on the toolbar.

Note: Your administrator must enable and configure some features.
The Domain Network and Communication Network panes have similar layouts and include the following main components: a toolbar, a grid, and a visualization pane.

The toolbar at the top of the pane includes buttons that you can use to interact with the visualization. For example, you can display only the nodes that contain selected participants.

The grid includes the following columns and information:
- **Nodes**: The first column displays the number of nodes in the visualization pane. Each node in the visualization pane represents a person or organization. Click the buttons in this column to show or hide nodes in the visualization.
- **Participants**: The second column displays the number of participants in the selected emails, and indicates the people or organizations who are active participants in the emails.
- **Name**: Click a name to select the emails that were sent or received by that person or organization.
- **Sent**: Click a number to select the emails that a person or organization sent.
- **Received**: Click a number to select the emails that a person or organization received.

**Note**: Your administrator must enable and configure some features.
Social network analytics: User interface elements

The visualization pane provides a graphic representation of the communication between people or organizations. Each node in the visualization pane represents a person or organization. The lines connecting the nodes show who communicated with each other.

Use the slider on the toolbar to zoom in and out of the visualization. To reset the visualization, click the Redraw button on the toolbar. You can also use your mouse to adjust the position of the nodes and zoom in and out.

The colors in each node show the proportion of emails that were sent and received. To display the number of emails that a person or organization sent and received, hover over a node.

Note: Your administrator must enable and configure some features.
Social network analytics: User interface elements

To select the emails that a person or organization sent and received, click a node.

When you select a node, a blue ring appears around the node. Red lines indicate all of the people or organizations who participated in the selected emails.

To view the number of emails and direction of the communication between two people or organizations, hover over a blue connecting line.

To select the emails between two people or organizations, click the blue line.
Work with Tools on the Documents page

The **Tools** menu on the Documents page includes a variety of features for working with documents. You can pin the options on the Tools menu to the toolbar.

---

**Note:** Your administrator must enable and configure some features.
You can view the progress of an active review using the **Review Dashboard**. The Review Dashboard includes a progress bar, graph, and reviewer matrix that display the review status of all documents in the case. The information in the Review Dashboard is pre-populated to show all documents in the case. If you select a different document set, coding field, or team, the dashboard updates accordingly.

To access the Review Dashboard, on the Case Home page, click **Review Dashboard** in the navigation pane.

**Note:** Your administrator must enable and configure some features.
Review Dashboard: User interface elements

The Review Dashboard includes the following information and options:

- **Document set**: The default option is All documents in the case. You can select a type of document set in the list, such as a binder. After you select a type, a second list appears. Depending on the type, select a specific document set from the list, or click the arrow and then select a specific document set. The progress bar, chart, and reviewer matrix update to show information for the newly selected set of documents.
- **Coding field**: This list prepopulates with a quick code field. You can change this field to any quick code field currently available in the case. When you select a different quick code field from the list, the Review Dashboard updates accordingly.
- **Progress bar**: Indicates the percentage of documents that are coded.
- **Estimated completion**: Indicates the estimated number of working days that are required to code the remaining uncoded documents, based on a rolling average review rate over the past seven days, excluding weekends.
- **Average documents coded per reviewer**: Indicates the rolling average of documents that are coded per reviewer per day, excluding weekends.
- **Doughnut chart**: Displays the number of documents and percentages of coded values for the selected coding field.
- **Team list**: Allows you to see the review status for different teams. The default option is All teams. When you select a different team, the information in the reviewer matrix updates, but the rest of the information in the Review Dashboard remains unchanged.

  **Note**: The available teams depend on each team’s security settings in the Review Setup section. Users with permissions to administer teams can choose from any team. Users without permissions to administer teams can choose from the teams that they are members of.
- **Reviewer matrix**: This table, located at the bottom of the page, displays coding metrics for individual reviewers, such as the average number of documents coded per day. A bar chart for each reviewer shows the percentages and number of documents that the reviewer coded for each quick code value. Hover over a bar to see the details. You can sort the columns in the Documents coded area.

  **Tip**: To export information in the reviewer matrix to a spreadsheet (.csv file), click the **Download** button on the toolbar.

**Note**: Your administrator must enable and configure some features.
Review text messages

You can review text messages that were created using iMessage, SMS, and WhatsApp. A text message thread displays the names or phone numbers of participants, attachments such as images or videos, and metadata such as the date of the conversation.

In the View pane, depending on the view format that you select, images and videos appear along with the accompanying messages. Images, videos, and other attachments are also created as separate Ringtail documents attached to the text message document.

A summary table displays the participants and the number of messages (MSG) and attachments (ATC) that were sent by each participant. To identify the content that was sent by specific people, in Formatted content view, select a participant's name or action in the summary table.

To add annotations to a text message document, create an image file of the document, and then annotate the image file.

**Tip:** To search for text message documents, create a search that includes the Document Type field with a value of iMessage, SMS, or WhatsApp.

**Note:** Your administrator must enable and configure some features.
You can review chat documents from Instant Bloomberg chats and persistent chat rooms. Chats are also called instant messages.

A chat includes a variety of information. In addition to the messages that participants send to each other, a chat can include the following information:

- Content that participants send to each other, such as messages, attachments, and invitations to ask other people to join the chat.
- Event logs that provide information about participants’ actions, such as when a person entered and exited a chat, or whether a person viewed the chat history to learn what happened in a chat room before they entered.
- Noise content that is distracting or irrelevant to the review, such as automatic disclaimers that are posted when people enter a chat.
- Metadata, such as the date and time of the chat, the names of participants, and the number of messages in the conversation. You can search for chat metadata and use it to focus the review. The metadata for a chat document appears in the Code pane.

Tip: To search for chat documents, create a search that includes the Document Type field with a value of **Bloomberg Instant** or **Bloomberg Persistent**.

Note: Your administrator must enable and configure some features.
Review Bloomberg chat documents

Depending on your review strategy, you can review chat documents in the View pane using the following views:

- **Lite chat (Formatted content view):** Quickly review only the content that participants sent to each other. Lite view displays a subset of chat information: messages, attachments, and invitations. The chat is color-coded based on participants' organizations. To identify content that was sent by specific people or organizations, select a participant’s name, organization, or action in the summary table. You can also display or hide keyword highlights.

- **Full chat (Image viewer):** Review all of the information in a chat, including content that participants sent to each other, event logs, and noise content. You can use event logs to determine the full context of a chat. For example, you can identify whether an individual participated in a chat when something important was said, even if they only viewed the content and did not send a response. As another example, you can analyze an individual's view history to determine when they learned about particular information.

Both chat views include a summary table that displays the organization names, participant names, and the number of messages (MSG), attachments (ATC), and invitations (INV) that were sent by each participant.

**Tip:** People frequently use informal language, abbreviations, and jargon in chats, and typos may be common. Because of this, you should adjust your search and review strategy to make sure that you do not miss any important information. If you use keyword highlights to identify important content, your administrator or review lead should make sure that any search term families include all relevant phrases.

If the chat file includes attachments, the attachments are attached to the chat document in Ringtail.

To add annotations to a chat document, create an image file of the document, and then annotate the image file.

**Note:** Your administrator must enable and configure some features.
Review transcripts

You can review transcripts on the Transcripts page.

To access the Transcripts page, on the Case Home menu, click Transcripts.

All users can perform the following tasks:
• Search and filter transcripts based on content, annotations, or transcript type.
• Annotate transcripts with highlights (transcript issues) and notes.
• Link transcripts to other objects in a case, such as related transcripts.
• Create a report of the annotations in one or more transcripts.
• Export transcripts to Microsoft Word.

Group leaders can perform the following tasks:
• Upload transcripts to a case.
• Download transcripts as portable case format (PCF) files, to share with users outside of Ringtail.
• Administer transcripts.

Note: Your administrator must enable and configure some features.
Need more help?

Visit [www.ringtail.com](http://www.ringtail.com) to read the release notes and access the online help.

*Note: Your administrator must enable and configure some features.*